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Chapter 1: Introduction 



1.1 WHAT IS LAND ACCOUNTING? 

Land accounting measures the change in the land and its attributes resulting from the 

impact of human and natural activity. The value of a set of land accounts is the ability to 

measure these attributes by examining stocks at different points in time to support policy 

around sustainable economic and environmental management. 

A land account consists of a series of tables, maps and graphs that show the economic, 

social and environmental interactions with land measured in both hectares and in dollar 

terms. 

1.2 Background 

Land, as an asset, represents a major proportion of Australia’s national economic value. This 

value was $3,614.4 billion in June 2010 (Australian System of National Accounts – National 

Balance Sheet, 5204.0). The land assets in Australia are owned, leased or used by 

governments, businesses and individuals for a variety of purposes and activities.  

Essentially all economic activities involve the use of some land (except for activities such as 

fishing) and there is a range of economic transactions related to land, either directly or 

indirectly (as an input to production or as a store of wealth). Administrative arrangements, 

such as zoning laws, constrain the availability of land for particular purposes.  

In Australia, land value is driven by physical characteristics such as location, vegetation 

cover, accessibility, climate, biodiversity, soils and mineral resources, as well as other factors 

such as land zoning and man-made improvements applied to the land and surrounds (e.g. 

proximity to main roads). Use of land can also result in degradation or improvements to the 

asset over time; for example, mining operations commencing in forested areas may 

destabilise natural ecosystems even though the land is usually required to be returned to its 

former status once the mining operations have ceased.  

Although there are many sources of data available to quantify the characteristics of land and 

how these characteristics change over time, the lack of integration of these data has meant 

that the information has not been fully utilised to support sound policy decisions. In 

response to this situation, the ABS developed and released Land Account: Great Barrier Reef 



Region, Experimental Estimates, 2011 (4609.0.55.001) in order to gain familiarity with the 

concepts and methods used to produce land accounts and review the quality and limitations 

of available data sources.  

Internationally, the United Nations Statistical Division has produced a framework, the 

System of Environmental-Economic Accounts (SEEA), which became an international 

standard in 2012. Australia already produces annual water and energy accounts consistent 

with the standard. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1.3. Case study 

Great Barrier Reef Land Account 

 

The first ABS Land Account in the Great Barrier Reef (GBR) was selected as it provided consistent, good quality 

and freely available source of land use and land cover data. The GBR was also selected as the catchments have 

a direct impact on the Great Barrier Reef which is the world's largest coral reef system.  

The process of developing a land account can be a complex procedure. A small region like the GBR provided a 

good opportunity to develop a proof of concept as realization of certain methods and to demonstrate its 

feasibility. By tracking changes in land use and land cover over time policy makers within the GBR are able to: 

• Better understand the relationships between the land and the economy; 

• identify critical gaps and deficiencies in land data; 

• examine the effectiveness or efficiency of private and public environmental protection and natural 

resource management expenditures; 

• support more targeted policy development by showing how land is used by different parts of the 

economy and how different economic activities may deplete or degrade the productive capacity of 

land; and 

• identify which industries currently own or manage land that is of significance to carbon storage and 

exchange. 

 

 

 



Land cover change in the Burnett Mary Natural Resource Management (NRM) in 

Queensland, Australia. 

 

This study will focus on monitor land cover change in the Burnett Mary Natural Resource 

Management (NRM) region in Queensland, Australia between 2005-06 and 2010-11. The 

methodologies provided are transferable and can be implemented for other regions and 

jurisdictions to produce land based statistics on land use or land cover. 

The Burnett Mary Region encompasses a land area of more than 56,000 square kilometres. 

Approximately 300,000 people live rural, regional and coastal lifestyles and the region is one 

of the fastest growing regions within Australia 

Extensive primary production is conducted within the region including, cane, horticulture, 

citrus and tree crops, grain crops, viticulture, dairy and grazing. Commercial forestry and 

tourism are also major industries represented within the region.  The region is incredibly 

biodiverse and contains many unique and endangered species. 

 

The outcomes of this study will be to populate the Land Account tables proposed in the 

System of Environmental-Economic Accounting 2012 Central Framework. This includes; 

Land cover net change matrix (hectares) 

An example of an unpopulated land cover net change matrix is presented in Table 1. This 

presents the opening and closing stocks of rateable value or land area for different land uses 

or land covers. In addition it presents the net increase and net decrease of land uses and 

land covers according to the land use or land cover it was converted from (in the case of 

increases), or to (in the case of decreases). Finally, it presents a total net change for each 

land use or land cover.  

 

The opening stock was calculated by summing all land use or land cover values by type for 

the beginning of the reference period. The closing stock was calculated by summing the 

opening stock and the total net change in rateable value or land area for each land use or 

land cover type. It is important to understand that the matrices show net changes, which 



may mask information. For example, if 100 hectares of 'Livestock Grazing' is lost in one place 

but added elsewhere, then no net change would be shown. 

Physical account for land cover (hectares) 

An example of an unpopulated physical account for land cover is presented in Table 2. It 

shows the opening and closing areas for different land cover types and various additions 

and reductions in those areas over the accounting period.  The data used in this example 

does not provide sufficient contextual information to attribute reasons for change. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1.4. Land cover data 
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Land cover is the physical surface of the earth, including the various soils, vegetation, 

geology, water bodies, and human built environments (e.g. agriculture, etc). Land cover is 

often captured using remote sensing. Some land uses, such as agriculture, share the same 

characteristics as land cover. However, in many other cases, land use can not be readily 

discriminated from land cover. For example, where the land cover is woodland, the land use 

may be sheep grazing. 

The land cover data used in this study has been sourced from Geoscience Australia’s 

National Dynamic Land Cover Dataset (DLCD). The DLCD is the first nationally consistent and 

thematically comprehensive land cover reference for Australia. It provides a base-line for 

identifying and reporting on change and trends in vegetation cover and extent. 

The DLCD includes snapshots of vegetation greenness for each 250 by 250 metre grid cell 

with each layer based on 2 years of Moderate Resolution Imaging Spectroradiometer 

(MODIS) data. The classification scheme used to describe land cover categories in the DLCD 

conforms to the 2007 International Organization for Standardization (ISO) land cover 

standard (19144-2). The DLCD shows Australia's land cover grouped into several broad 

classes. These reflect the structural character of vegetation, ranging from cultivated and 

managed land covers (crops and pastures) to natural land covers such as forest and 

grasslands.  

The source data for the DLCD is a time series of Enhanced Vegetation Index (EVI) data from 

the MODIS on the Terra and Aqua satellites operated by National Aeronautics and Space 

Administration (NASA).  

 

ABS has used DLCD based on MODIS data as the source of land cover information for all 

State & Territory Land Accounts produced in Australia 

1.5. Statistical Geography 

A statistical geography provides the extra dimension of location to statistics. A statistical 

geography effectively divides the area of interest, on which the statistics are collected, into 

spatial categories, called statistical areas, which allow the user to see not just how the data 

http://www.ga.gov.au/scientific-topics/earth-obs/landcover
http://www.ga.gov.au/scientific-topics/earth-obs/landcover


varies but also where it varies. An effective statistical geography is one which supports many 

uses and enables comparisons over time. 

In Australia land accounts have been disseminated on two statistical geographies including 

State & Territory & Natural Resource Management (NRM) regions. 

State & Territory: Australia is a federation consisting of six states and three federal 

territories. The Australian mainland consists of five of the six federated states (with the sixth 

state, Tasmania, being located on an island in close proximity to the mainland) and three 

federal territories (including the small, somewhat anomalous Jervis Bay Territory) which 

constitute the world's sixth-largest country by total area. All states and two of the three 

internal territories have their own parliaments and administer themselves; all remaining 

territories are administered by the federal government 

Natural Resource Management regions: In Australia Natural Resource Management (NRM) 

regions are a key set of geographical boundaries used to report Environmental based 

statistics. 56 regional NRM organisations cover all of Australia and its estuarine and coastal 

areas. NRM's are about the planning and delivery of programs that support healthy and 

productive country, viable communities and sustainable industries. 

 

 

 

 

 

 

 

 

 

 

 

 



CHAPTER 2: GIS data preparation 

Land based data is generally collected in a spatially enabled based format. The production of 

a Land Account requires an ability store, manipulate, analyse, manage, and present spatial 

data. 

In this study Geoscience Australia’s (GA) Dynamic Land Cover Dataset (DLCD) will be used as 

the primary input dataset. The DLCD has been provided for two accounting periods (2005-06 

and 2010-11) in a raster grid format. ESRI ArcMap will be used to prepare and structure the 

data into a tabular based format. A statistical software package such as Microsoft Excel will 

then be used present the data in the SEEA Land Accounting table format. 

2.1. ArcMap setup 

Begin this study by opening the ESRI ArcMap (Info) software package from your computer or 

laptop. ArcMap is the main component of Esri's ArcGIS suite of geospatial processing 

programs, and is used primarily to view, edit, create, and analyze geospatial data. 

Please ensure that the Standard Tabular, Tools Toolbar and Spatial Analyst extension are 

enabled. The toolbars can be turned on under the Customize > Toolbars menu, while the 

Spatial Analyst extension is enabled under Customize > Extension. 

 

The Standard toolbar most typically appears at the top of the ArcMap application window 

and is used for map printing, creating a new map, opening an existing map, saving your 

map, starting related ArcGIS applications, and more. 

The Tools toolbar is used for map navigation and query within the active data frame. 

ArcGIS Spatial Analyst tools let you analyse spatial relationships, build spatial models, and 

perform complex raster operation 

2.2. Loading input data 



This study will require three key datasets to populate the SEEA land cover tables (see Table 

1 & 2). This includes; 

• NRM_AUST_2012 – Vector (polygon) layer of all Natural Resource Management 

(NRM) regions in Australia. The Burnett Mary NRM will be used for this study. 

 

• DLCDv2_ 2005_2006_NNG_QLD – Raster grid of Dynamic Land Cover Dataset (DLCD) 

representing a two year interval (2005-06) of land cover data in Queensland. This will 

be used to populate the opening stock in the land cover tables. 

 

• DLCDv2_ 2010_2011_NNG_QLD – Raster grid of Dynamic Land Cover Dataset (DLCD) 

representing a two year interval (2010-11) of land cover data in Queensland. This will 

be used to populate the opening stock in the land cover tables. 

All three datasets have been stored in a Geodatabase 

\Bandung_Training_Oct_2015\Input_data.gdb\ 

 

 

 

 

 

 

 

 

 

 

 

GIS formats 

 

Land use and land cover data is often stored in a range of different GIS formats. This study examines the 

process of manipulating raster (grid) land cover data into the land accounting format. Similar methods 

(with minor process variations) can be adapted to produce statistics from vector based data. 

 

Vector: A representation of the world using points, lines, and polygons. Vector models are useful for storing 

data that has discrete boundaries, such as country borders, land parcels, and streets 

 

Raster: A representation of the world as a surface divided into a regular grid of cells. Raster models are 

useful for storing data that varies continuously, as in an aerial photograph, a satellite image, a surface of 

chemical concentrations, or an elevation surface. 

 

What is a geodatabase 

 

At its most basic level, an ArcGIS geodatabase is a collection of geographic datasets of various types held in 

a common file system folder, a Microsoft Access database, or a multiuser relational DBMS (such as Oracle, 

Microsoft SQL Server, PostgreSQL, Informix, or IBM DB2). Geodatabases come in many sizes, have varying 

numbers of users and can scale from small, single-user databases built on files up to larger workgroup, 

department, and enterprise geodatabases accessed by many users. 

 

 



Load the NRM boundaries (NRM_AUST_2012) and land cover data 

(DLCDv2_2005_2006_NNG_QLD and DLCDv2_2010_2011_NNG_QLD) in ESRI ArcMap using 

the Add Data  button from the Standard toolbar in ArcMap.  

2.3. Subset study region 

 

This study will focus on the Burnett Mary Natural 

Resource Management (NRM) region only. The 

boundary for this NRM will need to be subset from the 

National NRM layer. Use the Select by Attribute tool 

to subset the 'Burnett Mary' NRM as shown on the 

left. This query will select the Burnett Mary NRM 

region in the ‘NRM_AUST_2012’ attribute table. 

 

Right click the NRM_AUST_2012 layer in the Table of 

Contents and click Selection > Create Layer from 

Selected Features. This will create a new layer for the 

Burnett Mary NRM region. Right click this new layer in 

the Table of Contents > Data > Export Data. A new Geodatabase should be created to store 

this dataset. In the Saving Data tool navigate to the \Bandung_Training_Oct_2015\ folder. 

Click the New File Geodatabase button  and name this geodatabase 

\Working_Data.gdb\. Export this layer as 'Burnett_Mary_NRM' into this new geodatabase. 

Remove the temporary and National NRM layer and load the exported version back into 

ESRI ArcMap. 

 

2.4. Symbology 

 

By default the land cover grids will be symbolised as a stretched colour ramp ranging 

between 0-800. In reality the data is categorical and needs to be reflected as such. We can 

change the Symbology by individually clicking the land cover layers (starting with 

CDv2_2005_2006_NNG_QLD) in the ArcMap’s Table of Contents and navigating to 

Properties. Click the Symbology tab > Show Unique Values. In this example a layer file has 



been created which stores symbology properties. However classes can also be individually 

set and labelled in this tab if required. Click the Import > Open button to load the layer file 

which can be found in the following folder: 

\Bandung_Training_Oct_2015\DLCDv2_classification.lyr 

By importing this layer file we have automatically classified the data with suitable labels. 

This provides more contextual information about the data. Repeat this process for 

DLCDv2_2010_2011_NNG_QLD. 

 

 

2.5. Polygon to Raster 

The land cover data has been provided in a raster grid format 250x250m 2. The format and 

projection of this data has been defined by Geoscience Australia to allow for a consistent 

and comparable dataset. For simplification the reporting region (Burnett Mary NRM) will 

also be converted into a comparable raster grid format to streamline data integration. The 

ESRI ArcMap 'Polygon to Raster' tool enables users to convert polygon features to a raster 

dataset. Replicate settings as shown below.  

 



 

Cell assignment is set as Maximum Area (we want the maximum area of a polygon feature 

with a cell to be signed to that cell) and cell size to 250 which matches the Land Cover data. 

 

 

 

 

 

 

 

 

 

 

Under Environment Settings tab CHECK output coordinates are in GDA94 Australia Albers 

and ensure Processing Extent > Snap Raster is set to ‘DLCDv2_2010_2011_NNG_QLD’. By 

default, the output from this tool may have an "undefined coordinate system". If this 

occurs, you can associate the file with the correct projection (Australia Albers) using the 

Define Projection tool. 

 

The output of this tool should create a new raster layer ‘Burnett_Mary_NRM_Raster’ which 

is a 250x250 metre gridded representing of the original vector NRM boundary. Please note 

some generalisation will occur around the boundary edges. 

 

Spatial projections 

 

Users should consider how their data has been projected and ensure that this is consistent between years. 

 

Spatial data implicitly has coordinate values in either geographic or projected coordinates. A geographic 

coordinate system (GCS) uses a three-dimensional spherical surface to define locations on the earth; 

whereas, a projected coordinate system is defined on a flat, two-dimensional surface. Unlike a geographic 

coordinate system, a projected coordinate system has constant lengths, angles, and areas across the two 

dimensions. However, we need to explicitly define the coordinate system of our data. If we have undefined 

data, then we can use the Define Projection tool to define it. 

 



2.6. Extract by mask 

The land cover data provided covers the entire State of Queensland for both 2005-2006 and 

2010-2011. For this study we are only focusing on the Burnett Mary NRM region. It is 

recommended that users clip the extent of the land cover data to match this study region to 

reduce processing time.  

 

The ArcMap Extract by Mask tool can be used to extract the cells of a raster that correspond 

to the areas defined by a mask. In this example the ‘DLCDv2_2005_2006_NNG_QLD’ is the 

input raster and ‘Burnett_Mary_NRM_Raster’ the mask.  

 

This process should also be repeated for the 2010-11 DLCD dataset. The output rasters 

should be named ‘DLCDv2_2005_2006_NNG_BM’ and ‘DLCDv2_2010_2011_NNG_BM’ 

respectively. 

Symbology can be reapplied to these new datasets (see Step 2.4). 

2.7. Combine 

Next the ArcMap Combine tool will be used to combine the land cover grids (DLCD) for both 

2005-06 and 2010-11 into a single raster dataset.  

The Combine function assigns a unique value for each combination of values at each 

location and assigns the value to the value item in the attribute table of the output raster. 

The original value items, or the alternative field values if specified, are added to the output 

raster's attribute table: one for each input raster. The name of the input rasters is assigned 

to the item names. Each of these items carries the unique input combination of values from 

the input rasters that combined to produce the output value. These items retain the 



parentage that was used to produce the values for the output raster. This has been 

illustrated in the example below: 

 

The output file from the Combine tool should be named ‘DLCDv2_0506_1011_combined’.   

 

A copy of the ‘DLCDv2_0506_1011_combined’ layer will also need to be exported as a 

tabular dataset (i.e. comma delimited file). This file will provide a look-up table between the 

unique values for each combination of land cover categories between 2005-06 and 2010-11. 

Right click the ‘DLCDv2_0506_1011_combined’ layer in the ArcMap Table of Contents > 

Open Attribute Table > Table Options > Export. Set the output table to the working folder 

\Bandung_Training_Oct_2015\ (not Geodatabase), name the output 

‘DLCDv2_0506_1011_Combine_Excel’ and change the Save as type to Text file. Execute the 

export procedure.  



 

 

Do not add this output file to the current workspace. 

 

2.8. Tabulate area 

The final step in ArcMap involves creating a cross-tabulation between the combined land 

cover data ‘DLCDv2_0506_1011_combined’ and the reporting NRM region 

‘Burnett_Mary_NRM_Raster’.   

The ArcMap Tabulate Area tool is used to create cross tabulate areas between the two 

datasets. This is a type of zonal tool which takes a value raster as input and calculate for 

each cell a function or statistic using the value for each cell and all cells belonging to the 

same zone. The Zonal tools are grouped by how the zones are specified, by a single input 

value raster, or by a second zone raster. Replicate the settings as shown below: 

 

 

Export the table into the \Bandung_Training_Oct_2015\Working_data.gdb\ Geodatabase as 

‘DLCDv2_0506_1011_Tabulate’ .  



The output file will be automatically added to your ArcMap workspace. We can now export 

the results of Tabulate Area to Microsoft Excel.  

 

Right click the ‘DLCDv2_0506_1011_Tabulate_Excel’ layer in the ArcMap Table of Contents > 

Open Attribute Table > Table Options > Export. Set the output table to the working folder 

\Bandung_Training_Oct_2015\ (not Geodatabase), name the output 

‘DLCDv2_0506_1011_Tabulate_Excel’ and change the Save as type to Text file. Execute the 

export procedure.   

 

Do not add this output file to the current workspace. The physical change and net change 

matrices of land cover will be constructed from this output table in Microsoft Excel. 

 

 

 

 

 

 

 

 

 

 

 

 



CHAPTER 3: Excel data preparation 

Following Chapter 1 the land cover data will now be structured in a tabular dataset such as a 

comma delimited file (.csv). Statistical software such as Microsoft Excel, SAS Enterprise 

Guide or SPSS can now be used to restructure the data into the SEEA Land Account format. 

For this study Microsoft Excel has been used due to its availability and simplicity. 

3.1. Land cover classification 

In Step 2.7 we exported a table called ‘DLCDv2_0506_1011_Combine_Excel’ as a comma 

delimited file (csv). This included a unique value for each combination of land cover 

categories between 2005-06 and 2010-11. This table provides the basis to classifying land 

cover types for the output land account tables. 

 

Open this .csv in Microsoft Excel (File > Open). You will be presented with the Text Import 

Wizard. Click Delimited as you file type that best describes the data. The delimiter should 

then be set to Comma, Next and Finish.  

The imported data includes several columns including; 

• OBJECTID - count of rows; 

• Value - unique identifier for all land cover combinations; 

• Count – number of contributors for each unique combination; 

• DLCDv2_beta_2005 – land cover codes for 2005-06; and 

• DLCDv2_beta_2010 – land cover codes for 2010-11. 

Currently the land cover data only includes codes for 2005-06 (DLCDv2_beta_2005) and 

2010-11 (DLCDv2_beta_2010).  Table 3 below presents the land cover classification applied 

to Geoscience Australia’s Dynamic Land Cover Dataset (DLCD). This is based on the Food and 

Agriculture Organization (FAO) Land Cover Classification System (LCCS). To provide 

contextual information to the land accounting tables the land cover codes will need to be 

labelled in Microsoft Excel. 

Table 3. Land cover classification 



Land cover 
code Land cover label Land cover description 

0 Marine Water Marine Water. 

100 Primarily non-vegetated - terrestrial 
Terrestrial non-
vegetated areas. 

200 
Primarily non-vegetated - aquatic or regularly 
flooded 

Aquatic or regularly 
flooded non-vegetated 
areas. 

300 Cultivated and managed land - irrigated 

Cultivated and 
managed land with 
artificial application of 
water to the land or 
soil. 

400 Cultivated and managed land - rainfed 

Cultivated and 
managed land reliant 
on rainfall for water. 

500 Herbaceous vegetation 

A plant that has leaves 
and stems that die 
down at the end of the 
growing season to the 
soil level. They have no 
persistent woody stem 
above ground. 

600 Woody-shrubs 
A small to medium-
sized woody plant. 

700 Woody-trees 
A large sized woody 
plant. 

800 Wetlands 

land consisting of 
marshes or swamps; 
saturated land. 

 

Add two new column titles to the spreadsheet ‘DLCDv2_ 2005_2006_label’ and ‘DLCDv2_ 

2010_2011_label’  in 1F and 1G respectively. These will be used to label the land cover 

codes for both accounting periods. 

A nested IF Statement in Microsoft Excel can be constructed to add the land cover labels to 

the classifications table. The syntax of the IF Statement is =IF (Logic_Test, Value_if_True, 

Value_if_False). An example of the full nested IF Statement is shown in the screenshot 

below. It is recommended that users attempt to create this syntax themselves based on the 

information in Table 3. 



 

=IF(D2=0,"Marine Water",IF(D2=100,"Primarily non-vegetated - 

terrestrial",IF(D2=200,"Primarily non-vegetated - aquatic or regularly 

flooded",IF(D2=300,"Cultivated and managed land - irrigated",IF(D2=400,"Cultivated and 

managed land - rainfed",IF(D2=500,"Herbaceous vegetation",IF(D2=600,"Woody-

shrubs",IF(D2=700,"Woody-trees",IF(D2=800,"Wetlands",))))))))) 

Once the syntax has been constructed it can be copied for all cells in column F and G. 

Save this file over the original text file exported from ArcMap 

‘DLCDv2_0506_1011_Combine_Excel.txt’. This will be converted to a tab delimited format. 

 

3.2. Import and classify tabulated data  

Following the same procedure as Step 3.1 import the ‘DLCDv2_0506_1011_Tabulate_Excel’ 

and save the results an Excel Spreadsheet (xls or xlsx). This table includes: 

• OBJECTID - count of rows; 

• Value - unique identifier for all land cover combinations; and 

• BURNETT_MARY – NRM region with total area (squared kilometres) of each land 

cover combination. 

Rename the DLCDv2_0506_1011_Tabulate_Excel worksheet as ‘Data’. 



 

 

The Value field provides a common identifier between the tabulated land cover data in the 

Burnett Mary and the classification codes and labels. We will now add the output of Step 3.1 

(DLCDv2_0506_1011_Combine_Excel.csv’) as a separate tab within the current spreadsheet. 

This will enable us to link the two together and add the land cover classification to the ‘Data’ 

worksheet for both 2005-06 and 2010-11.  

In the bottom left of Excel click the Insert Workshop button. This will add a new worksheet 

called ‘Sheet1’. Rename this to ‘Classification’ .  

 

Open the ‘Classification’ sheet and navigate to Data tab and click the Get External Data > 

From Text button 

 

 

 

Users will be prompted with an Import Text File window. Navigate and open the 

DLCDv2_0506_1011_Combine_Excel.txt’ file. Import this file as a Tab delimited text file as 

previously demonstrated in Step 3.1. Import this data in $A$1 in the existing (Classification) 

worksheet. 

 



 

 

The land cover labels in the ‘Classifications’ worksheet can now be added to ‘Data’ 

worksheet based on the common Value field. The VLOOKUP function in Excel is a simple 

method which allows us to add data from one worksheet to another.  The follow is the 

syntax for the VLOOKUP function: 

 

VLOOKUP (lookup_value, table_array, col_index_num, [range_lookup]) 

 

• Lookup_value  - The value you want to look up. The value you want to look up must 

be in the first column of the range of cells you specify in table-array. 

• Table_array - The range of cells in which the VLOOKUP will search for the 

lookup_value and the return value. 

• Col_index_num - The column number (starting with 1 for the left-most column of 

table-array) that contains the return value. 

• [range_lookup] - A logical value that specifies whether you want VLOOKUP to find an 

exact match or an approximate match. 

 

Add two new column names in the ‘Data’ worksheet ‘DLCDv2_2005_2006_label’ and 

‘DLCDv2_ 2010_2011_label’ in D1 and E1, respectively. We will populate these columns 

using the VLOOKUP function with the corresponding land cover labels from the 

‘Classifications’ worksheet. The following is an example of the VLOOKUP function for D2 

(DLCDv2_beta_2005_label) 

 

=VLOOKUP(B2,Classification!B1:G39,5,FALSE) 

 

• lookup_value is the Value column from the ‘Data’ worksheet = B2 



• table_array is the full range of cells starting from the Value column in the 

‘Classification’ worksheet = Classification!B1:G39 

• Col_index_num is the column number (starting from the table arry range) of the 

return value, in this case the land cover label for 2005-06 = 5 

• [range_lookup] is set to FALSE as we want to search on the exact value. 

 

This formula can then be copied across the entire D column. The formula will also have to be 

replicated for column E (DLCDv2_beta_2010_label) but with a col_index_num of 6. 

 

3.3. Converting units 

By default ArcMap produced area calculations in square kilometres based on the Australia 

Albers projection. However the Australian Bureau of Statistics measures the majority of its 

area based information in hectares, including land use information the Australian 

Agricultural Census. Table 4 below provides the conversion table between square kilometres 

(km2) and several other common area measurements: 

Table 4. Square kilometre conversion 

Measurement 
1 km2 is equal 
to 

Sqaure metres 
             
1,000,000.00  

Hectares 
                         
100.00  

Sqaure miles 
                             
0.39  

Acre 
                         
247.10  

 

We can convert square kilometres to hectares using Microsoft Excel. This can be done by 

dividing the km2 value by 10,000. In the ‘Data’ worksheet add a new column heading in cell 

F1 labelled ‘BURNETT_MARY_HECTARES’. Insert the formula to convert km2 to hectares in 

F2 (=C2/10000) and copy it across that entire column.  



It is recommended that countries use the standard measurement which best suits their local 

requirements for land account data. 

3.4. Pivot table 

The data will now be transformed into a matrix using Microsoft Excels Pivot table function. 

Start by selecting all the columns and rows in the ‘Data’ worksheet.  Click the Insert Tab on 

the Excel toolbar and open the PivotTable tool. Replicate the settings as shown below: 

 

 

 

This will create a new worksheet called ‘Sheet2’ 

which includes the PivotTable setup menu on the 

left-hand side. In this example DLCDv2_ 

2005_2006_label should be set as the Row Label, 

DLCDv2_2010_2011_label as the Column label and 

BURNETT_MARY_HECATRES as the Value.  

 

By default the Value will be presented as a count. 

This can be changed by clicking ‘Count of 

BURNETT_MARY_HECATRES’ under the Value option 

and navigation to the Value Field Setting (as shown 



on the left). Change the summarise value field to Sum and click OK. Rename this worksheet 

as ‘Pivot’.  

 

The information presented in the ‘Pivot’ worksheet shows the total opening and closing 

stock of land cover in 2005-06 and 2010-11 (Grand totals) and the total (or gross) land area 

in hectares that remained or moved between categories over this period. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Chapter 4. Land cover net change matrix 

A net change matrix is one of the two table structures proposed for land accounts within the 

System of Environment-Economic Accounts (SEEA) Central Framework 2012. The net change 

of land cover (2005-06 to 2010-11) can be produced from the information available in the 

‘Pivot’ worksheet. 

 

Unlike total (or gross) change, net change can be positive or negative. It is important to 

understand that net changes are highly aggregated and need to be used with care. For 

example, if 100 hectares of agriculture land is lost in one place but added elsewhere, then 

no net change would be shown across the reporting. 

 

4.1. Copy and format pivot table  

 

A copy of the ‘Pivot’ worksheet should be pasted into a new 

worksheet called ‘Gross change’ at A1.  The Values (V) Paste 

function (as shown on the left) should be used as this provides 

data only with no excel formulas. 

 

The data pasted in ‘Gross change’ needs to be reformatted to 

provide a better structured and functional table. An example of 

the data is shown in Table 5. Attempt to replicate this format. 
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4.2. Transpose 

 

A second transposed copy of the total (or gross) change table will copied and pasted in a 

new worksheet called ‘Gross change transposed’. The Excel Microsoft transpose function 

returns a vertical range of cells as a horizontal range, or vice versa.  

 

Copy the formatted total (or gross) change table from the ‘Gross change’ worksheet. in cell 

A1 in ‘Gross change transposed’, navigate to the Paste function and click Transpose (T). 

 

By calculating and subtracting the transposed table form the original we are able to 

calculate the net changes between the land cover categories over the accounting period. 

 

4.3. Calculating Net change matrix output 

 

Create a new worksheet called ‘Net change matrix’. This will be the output table which 

presents the land cover net change between 2005-06 and 2010-11 for the Burnett Mary 

NRM in Queensland. 

 

The basic layout of the net change matrix is shown in Table 1. Attempt to replicate this 

structure in the ‘Net change matrix’ tab. The net change matrix will be populated from the 

information available in the ‘Gross Change’ and ‘Gross Change transposed’ worksheets.  

In the net change matrix the ‘Opening Stock 2005-06’ and ‘Closing Stock 2010-11’ can be 

populated from Grand Total column and row in the ‘Gross Change’ worksheet. In this 

example we will only copy the ‘Opening Stock 2005-06’ which is the column Grand Total in 

the ‘Gross Change’ worksheet. The ‘Closing Stock 2010-11’ will be manually calculated later 

in the process.  

 

Copy and paste the land cover ‘Opening Stock 2005-06’ Grand Totals using the Paste Values 

function. The overall region total (5,576,043 hectares) is not included as the SEEA net 

change matrix structure does not include an overall row total. 

 



 

 

The net changes are calculated by subtraction the land cover values in ‘Gross Change 

transposed’ from ‘Gross Change’ worksheets. In the ‘Net Change matrix’ worksheet click in 

C2 and input the following formula: 

 

='Gross Change transposed'!B2-'Gross Change'!B2 

 

This formula can then be copied across the worksheet to K10. A Total Net Change can also 

be calculated by summing the individual net changes across each row.  

 

Finally the Closing Stock 2010-11 can be calculated by summing the Opening Stock 2005-06 

with the Total Net Change (=SUM). These values should match the Grand Total row in ‘Gross 

Change’ worksheet.  

 

The result is the final land cover net change matrix for 2005-06 to 2010-11.  Compare your 

results to Table 6.   

 

What are some of key changes you can identify in this table? 
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14. Land Account Table – Physical account 

 

A physical account is the second main table structure proposed for land accounts within the 

System of Environment-Economic Accounts (SEEA) Central Framework 2012. The physical 

account of land cover (2005-06 to 2010-11) can be produced from the information available 

in the ‘Gross change’ worksheet from Step 12. 

 

14.1. Table structure 

Create a new worksheet called ‘Physical account’. The basic layout of the land cover physical 

account is shown in Table 2. Attempt to replicate this structure in the ‘Physical account’ 

worksheet. The physical account will be populated from the information available in the 

‘Gross Change’ worksheet created in Step 13.1. 

 

1.4.2. Opening and closing stock 

 

As done in Step 13.3 the ‘Opening Stock 2005-06’ and ‘Closing Stock 2010-11’ can be 

populated using the Grand Totals presented in the ‘Gross change’ worksheet. In this 

example we will only copy the ‘Opening Stock 2005-06’ which is the column Grand Total in 

the ‘Gross Change’ worksheet. The ‘Closing Stock 2010-11’ will be manually calculated later 

in the process.  

 

A Total should also be calculated by summing the ‘Opening Stock 2005-2006’ across the row 

(2) in the ‘Physical account’ worksheet. 

 

 

 

14.3. Calculating additions and reductions 

 



In the physical account the additions and reduction represent the total area (hectares) 

added or removed from an individual land cover category across the accounting period. 

The ‘Gross change’ worksheet includes all the necessary information to populate the 

additions and reduction fields.  

 

The total additions are the sum of the column (Closing Stock 2010-11) values for each land 

cover class where a movement between classes had been calculated in the ‘Gross change’ 

worksheet. In the example below the total additions for ‘Cultivated and manage land – 

irrigated’ is the sum of ‘Cultivated and manage land – rainfed’ (24,175 hectares) and 

‘Herbaceous vegetation’ (1,531.25 hectares). The total additions were 25,706.25 hectares.  

 

 

 

Manually calculate the additions for all land covers in the ‘Physical account table’. Do not 

include the value where the land cover remained unchanged, i.e Cultivated and manage 

land – irrigated’ (row) / Cultivated and manage land – irrigated’ (column). 

 

The total reductions are the sum of the row (Closing Stock 2005-06) values for each land 

cover class where a movement between classes had been calculated in the ‘Gross change’ 

worksheet. This value should be represented as a negative number. This can be done by 

subtracting the values from 0. In the example below the total reductions ‘Cultivated and 



manage land – irrigated’ is 0 minus the sum of ‘Cultivated and manage land – rainfed’ 

(6,456.25 hectares) and ‘Herbaceous vegetation’ (1,225 hectares). The total reductions were 

-7,681.25 hectares. 

 

Manually calculate the total reductions for all land covers in the ‘Physical account’ 

worksheet. Do not include the value where the land cover remained unchanged, i.e 

Cultivated and manage land – irrigated’ (row) / Cultivated and manage land – irrigated’ 

(column). 

 

14.4. Reason for change 

 

The physical account also aims to explain the different additions and reductions. However 

the data used in this study does not provide sufficient contextual information to attribute 

reasons for change. These categories will remain unpopulated. 

 

Below provides a summary of the reasons for change for the physical accounts. Does 

content information exist within your country to populate these categories?  

 

Managed expansion represents an increase in the area of a land cover type due to human 

activity. For example, crop areas may be converted to tree-covered areas as a result of 

silvicultural measures such as planting and seeding, or tree-covered areas may be converted 

to crop or grassland following tree clearing. Generally, the managed expansion of one land 

cover type will also lead to the recording of a matching entry for managed regression of the 

reducing land cover types. A matching entry is not recorded if there is a managed expansion 

in the total area of land within scope of the account (e.g., in the case of land reclamation). 

 

Natural expansion is an increase in area resulting from natural processes, including seeding, 

sprouting, suckering or layering. In the case of sparse natural vegetation and terrestrial 

barren land, the natural loss of vegetation from other vegetation types would lead to 

increases in these areas. Changes in the extent of permanent snow, glaciers and inland 

water bodies can also be due to natural variation, in rainfall, for example. Generally, the 

natural expansion of one land cover type will also lead to the recording of a matching entry 



for natural regression of the reducing land cover types. A matching entry is not recorded if 

there is a natural expansion in the total area of land within scope of the account (e.g., in the 

case where land is created through volcanic activity or landslide). 

 

Managed regression represents a decrease in the area of a land cover type due to human 

activity. As for managed expansion, a matching entry is recorded in all cases of managed 

regression, except in cases where there is a managed regression in the total land area. 

 

Natural regression should be recorded when the area of a land cover type reduces for 

natural reasons. As for natural expansion, a matching entry is recorded in all cases of natural 

regression, except in cases where there is a natural regression in the total land area (e.g., 

the loss of land due to erosion by the sea). 

 

Reappraisals can be upward or downward and can reflect changes due to the use of 

updated information that permits a reassessment of the size of the area of different land 

covers, for example, from new satellite imagery or interpretation of satellite imagery. The 

use of updated information may require the revision of previous estimates to ensure a 

continuity of time series. 

 

14.5. Finalising physical account 

 

The Closing Stock 2010-11 can be calculated by summing the Opening Stock 2005-06 with 

the total additions to stock (positive) and total reductions to stock (negative). These values 

should match the Grand Total row in ‘Gross Change’ worksheet.  

 

The result is the final physical account of land cover for 2005-06 to 2010-11.  Compare your 

results to Table 7.   

 

What are some of key changes you can identify in this table? 

 

 

 



 

 

 

 

 



 

 

 


